Eaton XP-503 with Visual Designer

DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITY

The information, recommendations, descriptions and safety notations in this document are based on Eaton Corporation’s (“Eaton”) experience and judgment and may not cover all contingencies. If further information is required, an Eaton sales office should be consulted. Sale of the product shown in this literature is subject to the terms and conditions outlined in appropriate Eaton selling policies or other contractual agreement between Eaton and the purchaser.

THERE ARE NO UNDERSTANDINGS, AGREEMENTS, WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF FITNESS FOR A PARTICULAR PURPOSE OR MERCHANTABILITY, OTHER THAN THOSE SPECIFICALLY SET OUT IN ANY EXISTING CONTRACT BETWEEN THE PARTIES. ANY SUCH CONTRACT STATES THE ENTIRE OBLIGATION OF EATON. THE CONTENTS OF THIS DOCUMENT SHALL NOT BECOME PART OF OR MODIFY ANY CONTRACT BETWEEN THE PARTIES.

In no event will Eaton be responsible to the purchaser or user in contract, in tort (including negligence), strict liability or otherwise for any special, indirect, incidental or consequential damage or loss whatsoever, including but not limited to damage or loss of use of equipment, plant or power system, cost of capital, loss of power, additional expenses in the use of existing power facilities, or claims against the purchaser or user by its customers resulting from the use of the information, recommendations and descriptions contained herein. The information contained in this manual is subject to change without notice.
Contents

PROTECT MODE
Creating a Backup/Restore Point for Your XP System .............................. 1

DOWNLOADING THE VISUAL DESIGNER PROJECT
Setting the XP-503’s IP Address .................................................. 2
Downloading to the XP-503 via Ethernet ......................................... 2
Downloading to the XP-503 USB Memory Device ............................... 3
Automatically Starting the Visual Designer Project .............................. 4
Updating the Visual Designer Version .......................................... 4
Checking the Current Version of Visual Designer .............................. 4
Updating the Visual Designer Runtime on an XP-702 Unit ..................... 5

WEB SERVER SETUP
Changing the Default Web Folder for IIS. ..................................... 8
Connecting to the Visual Designer Web Server from a PC ...................... 8
Manually Installing the Web Client ActiveX Control ........................... 8
Using the XP-503 to Serve the Web Client ActiveX Control ................. 9

MANAGING ACCOUNTS AND CHANGING PASSWORDS ......................... 9

VISUAL DESIGNER’S REMOTE AGENT UTILITY
How to Remove the Remote Agent Auto Startup ................................ 10

THE XP-503 FTP SERVER SETUP
How to Create Additional FTP Sites on the XP .................................. 11
Introduction

The Eaton XP-503 family is made up of high performance yet cost-effective, wide-screen, multi-touch operator interface (OI) products. The XP-503 family carries on Eaton's operator interface tradition of high performance balanced with ease of use. The XP-503 family sets the standard for hybrid OI systems by combining the flexibility of Microsoft® Windows® Standard Embedded 7 operating system with the stability and reliability achieved through a solid-state hardware design and Eaton’s exclusive Protect Mode™ feature that provides protection for unwanted changes to the operating system and software.

The XP-503 family provides the performance and flexibility of PC-based operator interfaces without the associated complexity and maintenance of a PC on the plant floor. With integrated high-speed Ethernet ports, serial ports, USB ports, DVI-output, and removable C-Fast solid-state memory, the XP-503 models can be adapted for a wide variety of user requirements.

The XP-503 family of products configured with the Visual Designer® software provides a range of solutions from basic operator monitor and control functions to full SCADA software capabilities with built-in Web Serving.

Whether replacing hard-wired pilot devices and pushbuttons or providing machine control and high-end SCADA functions, the XP-503 will suit a wide range of user requirements.

The remainder of this document describes some of the operating system features of the XP-503 system.
Protect Mode

The Eaton XP-503 family of products has a unique and exclusive Protect Mode feature that safeguards the integrity of files stored on the Ce drive of your operating system. This feature ensures that data and operating system files cannot be modified by anyone or corrupted by unexpected power disruptions. As a result, you can be confident that the XP-503 meets your rigorous industrial environmental requirements and can be protected against all unauthorized alterations.

For more details on the operation of Protect Mode, consult the XP-503 OS Windows Embedded information manual.

Creating a Backup/Restore Point for Your XP System

It is strongly recommended that the user back up the XP’s operating system after the unit is received, powered up, and placed in Protect Mode. This is so that in the unlikely event of an unintentional corruption of the operating system, the user will be able to recover the unit to its original factory settings. Under the Start menu’s Maintenance folder are utilities to back up and restore the XP unit and to create a system repair disk and system image.
Downloading the Visual Designer Project

Setting the XP-503’s IP Address
To download the Visual Designer project to the XP-503 over Ethernet, you will first need to establish an Ethernet connection to the XP-503 unit. This can be done many ways from a simple point-to-point connection with a Cat 5 crossover cable or by using an Ethernet hub, switch, or router. Note that some PC’s Ethernet ports will autosense the transmit/receive lines and provide internal crossover capability. If your PC has this feature, you can use a standard Cat 5 patch cable to connect to the XP-503. The XP-503’s two Ethernet ports are configured at the factory for dynamic IP addresses (DHCP). In most applications, the XP-503’s IP address will be set to a static value. If you are unsure of how or what to set the XP-503’s IP address, please consult your local IT support personnel. Once you know the IP address of the XP unit, take the following steps:

1. Open Control Panel with Start > Control Panel and then double click to open the Network Connections dialog.
2. Double-click on one of the Local Area Connection icons and scroll down in the connection items list to select Internet Protocol (TCP/IP) and then click on the Properties button.
3. Select the radio button labeled “Use the following IP Address:” and then type in the IP address and subnet mask (e.g., 10.155.0.12 and 255.255.255.0) and click OK.
4. Click OK to close the Local Area Connection Properties dialog and then close the Network Connections window.

Note: There are two Ethernet ports on the XP unit. The first one is physically located next to the DVI port (closest to the 24 Vdc power connector) and is listed as Local Area Connection 1. The other is listed as Local Area Connection 2. Both are 10/100/1000Base-T ports.

Downloading to the XP-503 via Ethernet
The following instructions on downloading via Ethernet or USB memory device direct you to locate the Visual Designer project on the protected “C” drive of the XP unit. Because any changes to that drive are only stored temporarily in volatile DRAM until a Protect Mode Save action is taken (see section on Protect Mode Save earlier in this document), it is important that you remember to do this with every change made to the project. Furthermore, by default, all archiving of Trends, Alarms, or Events goes to the HST and Alarm sub-folders of the project. It is critical that a project that is performing these archiving functions redirect the archiving to either the D drive or any other permanent memory resource, either local or on a network. Otherwise the data will not be archived and instead be re-directed to volatile DRAM, which potentially could fill up and stop the Windows operating system. The following is an example of the VB Script commands that will redirect both Trend and Alarm/Event archiving to the D drive. In this example, it directs the archiving to folders that would need to first be created manually on the D drive because this command will not create directories when executed. These commands must be placed in the Startup Script under the Tasks tab of Project Explorer in the Scripts folder, which executes once on startup of the project.

\$SetAppHstPath(“D:\Data\Trends”)  
\$SetAppAlarmPath(“D:\Data\Alarms”)  

Note: The XP-503 includes a utility called Junction.exe that automatically sets the C:\Cfg\APPL\HST and ALARM folders to write instead to the D:\Data\TRENDS and ALARMS folders negating the need for these commands in the application as long as the user loads the project to the default C:\Cfg\APPL folder as instructed below.

Once you have an Ethernet connection established between your development PC and the XP-503 unit, make sure that the Remote Agent that opens by default at XP’s startup is running. If it was shut down manually, you can restart the Remote Agent with Start > All Programs > Eaton > Visual Designer vX.Y > Remote Agent. Then open your Visual Designer project on your PC and click on the Connect button on the Home tab of the Ribbon under the Remote Management Group. In the Network IP property, type in the IP address of the XP-503 as shown below and click on the Connect button.

If your Ethernet connection is configured correctly, the Status property will change to show “Connected to Visual Designer vX.Y” as shown below.
Next, click on the “Project” tab on the left side of the Remote Management window. Verify that the target is set correctly to C:\Cfg\APPL\ . If it is not set correctly, click on the button labeled “…” to the right of the target property and select the C drive and browse to the Cfg\APPL folder.

Once the target path is set, make sure to uncheck the checkbox “Only newer files” and then click the Download… button. An Execution Environment dialog will display, informing you to verify that the target platform’s license supports the Product Type configured. If the XP’s license is sufficient to run the project, click on the Yes button, which will begin the download operation. Note that the Status: property will update with every file downloaded. After all files have been successfully downloaded, the Status will indicate “Files were sent successfully.” To start the project on the XP, you can either click on the Run button on the Remote Management dialog box on your PC or click on the Start button on the Remote Agent dialog on the XP.

**Note:** You must be sure to perform a Protect Mode Save operation after you download to the XP-503 in order to permanently save the changes to Visual Designer’s protected C:\ drive that are made during the download process. Even if you decide to locate the project on the non-protected D:\ drive, the name and location of the project file is stored in the Project Settings.ini file, which is located on the C:\ drive.

### Downloading to the XP-503 USB Memory Device

You may also choose to manually load your Visual Designer project from a USB memory device rather than use the Ethernet transfer method. To do so, you should take the following steps:

1. Copy the entire project folder from your development PC to a USB memory device. Note that by default, the project folder is stored under “My Document\ Visual Designer vX.Y Projects” in a folder name matching the project name when it was created.

2. Place the USB memory device in a USB port of the XP-503 and paste everything under the project folder (not including the project folder) into the C:\Cfg\APPL folder of the XP unit (e.g., Alarm, Config, Database, Hst, Screen, Symbol, and Web folders plus the APPNAME.APP file; plus any user created files and folders under the project folder).

3. Open Visual Designer on the XP-503 Start > All Programs > Visual Designer vX.Y > Visual Designer vX.Y.

4. A Visual Designer error dialog should pop up saying “The Project was not found in the …” This is normal, click OK.

5. A Visual Designer warning dialog should then pop up saying “License not found!” This is also normal, click OK.

6. The Visual Designer window will then display with no project selected. Click on the File Open icon on the Quick Launch toolbar or click the Visual Designer icon in the upper left corner of the window and select “Open Project” from the drop list.

7. Browse to the C:\Cfg\APPL folder of the XP and select the .APP file located in that folder and then click on the button labeled “Open”.

8. Another Visual Designer license warning dialog may pop up. If it does, click OK.

9. Once the project loads and shows in the Project Explorer section, you may close the Visual Designer application. This step will properly configure the Program Settings.ini file on the C:\ drive.

10. Perform a Protect Mode Save operation. Go to Start > All Programs > Protect Mode Manager and select the Protect Mode Save tab and click the Commit button.
Automatically Starting the Visual Designer Project
The Visual Designer project is set to automatically run when the XP-503 boots up. If you wish to have the user manually start the project, you will need to remove the Startup shortcut from the Windows startup folder. To do so, take the following steps:

1. From the XP, click Start > All Programs > Windows Explorer.
2. Browse to the folder “C:\Documents and Settings\All Users\Start Menu\Programs\Startup” and delete the StartUp shortcut icon from that folder.
3. Close the Windows Explorer window and perform a Protect Mode Save operation. Start > All Programs > Protect Mode Manager and then select the Protect Mode Save tab and click the Commit button.

After the XP saves the changes to Windows C:\ drive, it will reboot and automatically launch the Remote Agent but not the Visual Designer project. The user can then click on the Start button of the Remote agent to manually launch the Visual Designer project.

Updating the Visual Designer Version
For proper runtime operation, it is critical that the version of Visual Designer running on an XP unit match the version of Visual Designer used to develop the runtime application. On new XP units, the operating system image may have an older version of Visual Designer runtime software than the version currently available from Eaton’s website. Because some users choose not to update their development software to the latest version available, the version of Visual Designer runtime software, which comes installed on a new unit, may be newer than the version they are currently using for development. For these reasons it is important to follow the recommended procedure for installing the correct version of Visual Designer runtime files on an XP unit when the development and runtime versions don’t match.

Checking the Current Version of Visual Designer
To check the runtime version on an XP unit or on your development PC, you follow the same process.

1. Open the Visual Designer editor with Start > All Programs > Eaton > Visual Designer vX.X > Visual Designer vX.X.
3. If the runtime version, Service Pack number, Patch number, or Build Number do not agree, then you need to install the version of software that the project was developed in, i.e., the version of Visual Designer that is running on the development PC.

Updating the Visual Designer Runtime on an XP-702 Unit

1. Before beginning the update process, you should first disable Protect Mode on the XP unit.

**Note:** Before disabling Protect Mode, it is strongly recommended that you have a good backup of the XP’s operating system. If you have not already done so, refer to the previous section in this document titled “Creating a Backup/Restore Point for your XP System”. Protect Mode, when enabled, prevents permanent or unwanted change to the XP’s Windows operating system. For large changes to the Windows operating system, such as installing a large new program, the user has the ability to disable Protect Mode on the XP, and then after installing the program, to re-enable Protect Mode to ensure operational reliability of the unit. To disable Protect Mode, open XP’s Protect Mode Manager **Start > All Programs > Protect Mode Manager** (top of the list). In the Protect Mode Manager window, click the Advanced tab as shown below and click on the button labeled **Disable Protect Mode**. This will cause the XP unit to reboot.

2. Once the unit has booted up, Protect Mode is no longer active.

**IMPORTANT**

With Protect Mode disabled, the XP unit can be thought of as a normal Windows Industrial PC but without Anti-Virus software or the latest Microsoft Security Updates. Care should be taken to not expose the XP to the risk of Virus infection by removing it from any network and making sure any USB memory devices used on the unit while running without Protect Mode have been scanned for viruses and other malware. Also, avoid removing power from the unit during installation or removal of software as this may result in a corrupted File Allocation System. All reboots should be done through the Windows shutdown options.

3. Now with Protect Mode disabled, uninstall the current version of Visual Designer by opening Control Panel and selecting **Programs and Features**.

4. In the Programs and Features dialog, double-click the Visual Designer vX.X.
5. After a short while, you may receive a popup dialog indicating an error as shown below. This is normal. If you see this error, simply click **OK** and it will continue through the rest of the uninstall process.

![Error Dialog](image)

6. When prompted to completely remove the selected application and all of its features, click on **Yes**.

![Confirmation Dialog](image)

7. Windows will begin uninstalling Visual Designer. When complete, a Window stating that the uninstall process is complete will be displayed. Click the **Finish** button.

8. Once you have uninstalled Visual Designer you must locate the installation files used to install Visual Designer on your development PC and copy them to a USB Memory stick (scan first for viruses and other malware). If you cannot locate the installation files, you can redownload them from the Eaton website at [www.eaton.com/oi](http://www.eaton.com/oi) and then go to the OI Software section, and click on the Visual Designer Software under the Software Downloads section. After the download is complete, you can then unzip the installation files to your memory stick.

9. Insert the memory stick into one of the XP’s USB ports and open the folder to view the files and browse to the Disk1 directory and double-click on the Setup.exe icon.

![Launch Setup.exe](image)

10. Once the installation begins, you will be prompted to select the language to use for installing the software where the default is English (United States). Select the language and click **OK**.

11. Next, you may be prompted to install any prerequisite software components that are not as yet installed on the XP unit. If prompted, click on the **Install** button.

12. Once the prerequisite components have installed completely you’ll come to the Installation Welcome Screen. Click **Next>**.

13. Next you’ll be presented with the License Agreement Screen. Once you’ve read the license, you should click on the **Yes** button to agree to the license and proceed.

![License Agreement Screen](image)
14. On the Customer Information screen, you can modify the User Name and Company Name properties and then click Next. 

15. On the Select Features dialog, uncheck the optional installation components as shown below (Demos, Symbol Library, Runtime for Windows Embedded Compact, Runtime for Windows Embedded Standard, Windows Mobile, Collaboration Tools) and then click Next. 

16. On the next dialog, click Install to begin the installation process.

17. After the “Installation Wizard Complete” dialog is displayed, click Finish to close the dialog.

18. After the Visual Designer software has been updated, you will need to update the shortcuts in the Start menu. To do this, open the Start menu and expand both the Startup folder and the Eaton>Visual Designer vX.Y folder.

19. If there are already shortcuts in the Startup folder for the Remote Agent and Startup programs, right-click on each shortcut icon and select Delete.

20. Once the Startup folder is empty as shown in the figure below (left side image), hold down the Control key on your keyboard and then left-click and drag the shortcut icons from the Visual Designer folder to the Startup folder. If you only have a mouse connected and no keyboard, you can right-click and drag the shortcut icons to the Startup folder. When you release the right mouse button, you’ll be prompted to “Copy here”. After copying the shortcuts, the Visual Designer and Startup folders will look like the right side image below.

21. Next you need to make sure that the Visual Designer license type is still set to Softkey. To check this, go to Start > All Programs > Eaton > Visual Designer vX.Y > Register. If the license was changed to Hardkey by the installation of the new version of software, then you need to change it back to Softkey and click “Check”. A warning dialog box will appear; click “Yes” to change the protection method back to softkey. The subsequent “Softkey Settings” dialog should show the correct license settings for the unit. Click “Close” and then click “Close” on the Protection Manager Dialog.

22. Next you need to re-enable Protect Mode on the XP unit. To enable Protect Mode, open XP’s Protect Mode Manager Start > All Programs > Protect Mode Manager (top of the list). In the Protect Mode Manager window, click the Advanced tab and click on the button labeled Enable Protect Mode. This will cause the XP unit to reboot. Once it reboots, Protect Mode is once again active protecting the operating system from unwanted change, malware, or sudden power loss and the XP unit’s Visual Designer software version matches that of the development PC.
Web Server Setup

The XP-503 has Internet Information Services installed and set up to support Visual Designer’s built-in web serving feature. The Visual Designer factory-installed license allows for 1 simultaneous web client connection but may be field-upgraded on the XP-503 to allow for up to 128 simultaneous web client connections. The IIS settings point to the `C:\Cfg\APPL\Web` folder as the default web location so that if the user loads their project to the `C:\Cfg\APPL` folder, the projects web pages will all be placed in the `Web` subfolder so that no changes are required to the IIS settings for the web serving feature to work.

Changing the Default Web Folder for IIS

If for some reason the user wishes to place their Visual Designer application folder in a different location, then they must take the following steps to relocate the default web folder on the XP.

1. Open Control Panel and then open Administrative Tools.
2. From the Administrative Tools folder, open Internet Information Services Manager.
3. Expand the Local Computer folder on the left side and then expand the Sites folder.
4. Click on the Default Web Site and in the Actions pane on the right, choose Advanced Settings …
5. Click on the Physical Path property and then click on the Browse … button to the right. Navigate to and select the web folder under your desired Visual Designer Project folder and then click OK.
6. Verify that the correct path is now shown in the Physical Path property and then click OK to close the Advanced Settings dialog.
7. Close all remaining windows and perform a Protect Mode Save operation.

Connecting to the Visual Designer Web Server from a PC

In order to view the Visual Designer web pages over a network connection from a PC, you need to know three things:

1. The IP address of the XP running Visual Designer.
2. The name of Visual Designer’s startup screen.
3. A user name and password configured in the security settings of Visual Designer.

You can then open Microsoft Internet Explorer and in the address bar, type in the address of the XP followed by a forward slash, followed by the name of the startup screen with an .html extension. For example, if the XP is at IP address 192.168.1.20 and the startup project is named “Startup,” then the following would be the address line to get to the XP’s starting web page:

http://192.168.1.20/Startup.html

The following steps take place when it attempts to display the startup web page.

1. The startup web page HTML code is sent to the Internet Explorer browser.
2. In the header of the code, the browser is notified that it needs a specific version of an OCX (ActiveX) control installed, named ISSymbol.ocx, and if it is not installed or if it is installed but is an older version than is required, Internet Explorer is directed to the Eaton website to automatically install the ActiveX control.
3. If the user is simultaneously on the Internet and connected to the XP, and depending on IE’s security settings, it will prompt the user to right click on the browser header to allow blocked ActiveX content. If the user does so, it will download the ActiveX control and install it.
4. Once the correct version of the ActiveX control is installed or verified, the user will be asked to enter their User Name and Password configured in the Visual Designer security settings. If no security has been set up in Visual Designer, the user named “Guest” with no password will suffice to open the startup screen.

Manually Installing the Web Client ActiveX Control

If the PC trying to connect to the web server has the same Visual Designer version installed as the runtime system, then the ISSymbol.ocx will already be installed. However, in most cases, Visual Designer will not be installed on the web client’s PC. If the user is not connected to the web when first attempting to connect to the Visual Designer web server, Internet Explorer will not be able to show the web page. In this case, the user will have to manually install the ActiveX control to their PC.

To install the ActiveX control, follow these steps:

1. Connect to the Internet and go to the Eaton website’s Operator Interface product section with the link www.eaton.com/oi.
2. Select the link for Operator Interface Software.
3. In the Software Downloads area, click on the Visual Designer Software link.
4. After providing your email address, you will be redirected to the Documentation Results screen where you can download the current Visual Designer Symbol Library (ISSymbolVM.cab).
5. After downloading the CAB file, you should be able to open it with any zip file utility and extract the entire CAB file contents to a temporary folder on your PC.

6. Run the Setup.exe file from the temporary folder, following the prompts to install it in the default location and to install all components when prompted.

7. After installation is complete, click the Finish button. You will then be able to connect to the Visual Designer web server from your PC’s Internet Explorer application.

**Managing Accounts and Changing Passwords**

There is an administrator account named **Administrator** set up on your Eaton XP-503 unit when it was shipped from the factory. The password for the **Administrator** user account is **Administrator**.

**Note:** XP-503 passwords **are** case sensitive. XP-503 user names **are not** case sensitive.

The XP-503 is set up to automatically log in to the **Administrator** account, which is why the normal Windows XP Security dialog box does not appear upon boot-up.

If you are connecting your Eaton XP-503 unit to a larger network, you may wish to modify the **Administrator** account name and password to protect the XP-503 unit from unauthorized access. For more details on managing accounts, password administration, and auto logon functionality, consult the XP-503 OS Windows Embedded information manual.

**Using the XP-503 to Serve the Web Client ActiveX Control**

In some applications, a remote user will not be able to be connected to the Internet and the XP-503 simultaneously. Rather than force every remote user to manually install the web client ActiveX control, it may be preferable to store the ISSymbolVM.cab file on the XP and have the ActiveX control automatically installed from the XP rather than from the Eaton website. To set up the XP to automatically serve the ActiveX control for first time, thin client PCs, copy the ISSymbolVM.cab file from the XP’s Visual Designer install folder (C:\Program Files\Eaton\Visual Designer vX.Y) and paste it into the XP unit’s default web folder, and then take the following steps.

1. Open up the Visual Designer application on your development PC and go to the Project tab of the Ribbon and click on the Thin Client icon in the Web group.

2. In the Project Settings dialog web section, click on the Advanced… button.

3. In the Advanced dialog, change the ISSymbol URL property to point to the IP address of the target XP-503. For example, if the XP’s IP address is set to 192.168.1.20, set the ISSymbol URL property to: http://192.168.1.20/. Once the correct URL is entered, click on OK.

4. Click on the round Visual Designer icon in the upper left corner of the development window and choose Publish (or from the Publish sub-menu Save All as HTML).

5. After all screens have been published, connect to the XP and download the project as described in the section “Downloading to the XP-503 via Ethernet.”
Visual Designer’s Remote Agent Utility

Visual Designer’s Remote Agent utility is set to automatically start when the XP-503 starts. This utility is the connection that the development software uses for uploading, downloading, and online editing of the Visual Designer project. If for some reason you are unable to connect to the XP-503 from the development software, make sure that the Remote Agent has not been closed by the local user. There are only three buttons on the Remote Agent. The Start button will start the Visual Designer application or restart one that was closed. The Setup button allows the user to switch from the default TCP/IP connection to a Serial Port connection to the development PC, and to configure password security for remote connections to the Remote Agent. The last button, Exit, will bring up a prompt box asking if you are sure you want to exit the Remote Agent utility, with Yes and No response buttons.

How to Remove the Remote Agent Auto Startup

To delete the Remote Agent shortcut from the Windows Start menu, follow these steps.

1. On the XP-503, Open Windows Explorer, Start > All Programs > Windows Explorer.

2. Browse to the folder “C:\Documents and Settings\All Users\Start Menu\Programs\Startup” and delete the Remote Agent shortcut icon (right-click > Delete).

3. Close the Windows Explorer window and perform a Protect Mode Save operation. Start > All Programs > Protect Mode Manager and then select the Protect Mode Save tab and click the Commit button.

After the XP saves the changes to Windows, it will reboot and no longer automatically start the Remote Agent.

Normally the user would not change the default behavior of the Remote Agent utility as it supports remote features that simplify the development process. However, if you wish to disable the automatic launch of the Remote Agent to prevent remote management, you can delete the Remote Agent shortcut from the Windows Start Menu, Startup folder.
The XP-503 FTP Server Setup

The XP-503 is set up to provide FTP server services. The default FTP sites are named CDrive and Data and their paths are Ce:\ and De:\ respectively. To connect to the FTP site from a PC over Ethernet, you must know the IP Address of the unit and a valid user name and password. The user name Administrator and password Administrator are configured by default. If, for example, the XP's IP Address were 192.168.1.20 you would open Windows Explorer on your PC and type in the following in the address bar:

\ftp://192.168.1.20/Data

The following Log On dialog will display:

Type in the correct user name and password and click on the Log On button. If the name and password are entered correctly you will be able to view the contents of the D:\ drive on the XP unit as well as copy and paste files to and from any folder on that drive.

**Note:** The user name is not case sensitive but the password is case sensitive.

How to Create Additional FTP Sites on the XP

It may be useful to allow remote FTP access to other areas of the XP. As an example, perhaps you wish to be able to view all files on the C:\Cfg\APPL folder through the FTP server connection. To do this you would take the following steps:

1. Open Control Panel and click on System and Security and then open Administrative Tools.
2. Double-click on the Internet Information Services (IIS) Manager shortcut.
3. Expand the Local Computer name folder and then expand the Sites folder. Then expand the Default FTP Sites folder and select the Default FTP Site.
4. With the Default FTP Site highlighted, right-click on it and select Add Virtual Directory…
5. In the “Add Virtual Directory” dialog, enter the name you wish to call your new FTP site in the Alias property, e.g., “APPL”.
6. Next click on the “…” ellipsis button to browse to the desired folder, e.g., “C:\Cfg\APPL” and then click OK.
7. Verify that the correct path shows in the Physical Path property and then click OK.
8. Close all open windows and perform a Protect Mode Save operation to make these changes permanent.

After the system reboots, users with valid password access will now be able to access the additional FTP sites.
Eaton is dedicated to ensuring that reliable, efficient and safe power is available when it’s needed most. With unparalleled knowledge of electrical power management across industries, experts at Eaton deliver customized, integrated solutions to solve our customers’ most critical challenges.

Our focus is on delivering the right solution for the application. But, decision makers demand more than just innovative products. They turn to Eaton for an unwavering commitment to personal support that makes customer success a top priority. For more information, visit www.eaton.com/electrical.